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Introduction Accordlt is a text processing utility intended for use with Accordance Bible
Software. It allows you to

The Accordit
window

display verses from any Bible installed in your copy of Accordance
edit the text using Accordance fonts and text capabilities

copy and paste text into a word processor

save text as a text file or RTF file

import documents with LaserHebrew or LaserGreek, and convert
those fonts to Accordance fonts.

The correct version of AccordIt for your Mac OS should be placed and kept
in the Accordance folder so that it can access the Accordance settings f folder
and the texts used by Accordance.

Version 2 of AccordIt has been updated to run natively in OS X and to access
the texts formatted for Accordance 6.x. It has NOT been updated with all
the text export options, such as Copy as Citation or Unicode, that are now
offered in Accordance. Accordlt is mainly provided as an update for those
who have been using this utility, and as a quick means of copying verses
without running Accordance.

Using AccordIt

AccordlIt uses the Accordance settings file to get the list of Bible text
modules available to Accordance, and the default text display settings for
each module. Any changes you make to these settings in Accordance will
also affect AccordIt. However, changes in AccordlIt settings do not affect

Accordance.
8eee Text
When you open AccordIt KIVS 3. Copy All
a new Text window Yerse references:
appears. Gen 1.1, 2:1

The text pop-up menu
shows the current
default text and allows
you to select from the finished, and all the host of them.
other Bible texts you
have available.

Caution: If you remove

Add

Gen. 1:1 In the beginning God created the heaven m
and the earth.
Gen. 2:1 Thus the heavens and the earth were

‘§ SR

or change the
order of the
texts using the
Edit Modules item in Accordance while Accordlt is open, the
menu will not function correctly.

Verse references are typed into the entry box under the prompt.

The text window pane is used to display and edit text. The insertion point is
indicated by a small selection when the cursor is in the entry box.



Getting verses

Editing text

Copying to a
word processor

Pressing the tab key when the cursor is in the text pane selects all the
contents of the entry box, so a new entry replaces the previous contents.
Pressing the tab key when the cursor is in the entry box returns the cursor to
the insertion point in the text pane.

Clicking the Add button (or pressing return or enter) adds the new
references to the text pane at the insertion point. The text is displayed in the
default styles and colors. If there is text selected in the text pane, it will be
replaced by the new references. Up to 150 verses may be added at one time.

The Copy All button copies all the text in the text pane to the clipboard.

To get the text of certain verses into your word processor follow these
simple steps:

e Set the text pop-up menu to the desired text

e Enter the verse references in the entry box

e (Click Add or press return or enter

e C(lick Copy All, then click on the word processor and paste as
usual, or drag the selection over (see below).

Unlike the Accordance Search window, in AccordIt you can edit the text pane
in any way you want. The Set Initial Text Display... (Edit menu or $-T)
affects only new verses added to the pane, but all the other Edit and Text
menu items can be used to change the appearance of the text, or enter your
own words.

AccordIt supports the Macintosh drag and drop feature. When you select
text, the cursor changes to a white arrow and a square. You can now drag the
selection to anywhere in the window, or to another window.

Holding the option key down while you drag copies the selection to the new
location (a plus sign on the cursor indicates that it will make a copy).

If you attempt to drag the selection to a part of a window which cannot
accept it, the cursor changes to a large X. If you drag the selection to a
window which does accept it, the selection appears to return to its original
location when you release the mouse button.

Use the Copy or Cut items (Edit menu or $8-C or X) or the Copy All button
to copy text to the clipboard. Then click on the word processor document,
and select Paste (Edit menu or 38-V) to paste it at the insertion point.

Note: Not all word processors accept font and style information from
the clipboard. You may need to reformat the text if it does not
appear the way you want.

You can also simply drag your selection and drop it in your word processor
document. Most word processors support this feature.

If you drag and drop your selection onto a Finder window or the desktop,
a text clipping is created. It forms a stand-alone file which can be opened
in the Finder, and copied to the clipboard at any time. Some programs that
support drag and drop also allow you to drag the text clipping and drop it
into a document.
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Saving as a file

Plain Text...
RTF...

File

Edit

Text

The Save As Text File submenu (File menu) lets you saves the text from
the front window to a file. The file can be saved in either ASCII or Rich Text
Format (RTF). The Greek and Hebrew text conversion options currently set in
Set Clipboard Options... (Edit menu)also apply, as described below. Rich
Text Format preserves the font and style information, and can be read by
most word processors. You can use this method to export your work if your
word processor does not accept this information from the clipboard. Saving
text files is described in Chapter 23 of the Accordance User’s Guide.

AccordIt Menu Items

New N
The File menu lets you open a New window Close W
(%8-N), Close the front window ($-W), Save As Save As Text File >
Text File, or Quit (%-Q). Quit #®Q

The Edit menu has the standard Undo
(88-Z), Cut (38-X), Copy (38-C), Paste (8-

V), Clear, and Select All ($-A) items as Undo #Z
well as the following special items: Cut X
e Copy Style (38-[): Stores the styles Copy #C
of the selected text. The styles Paste #EV
include the font, size, style and Clear
color. Select All A
e Paste Style (38-]): Replaces the Copy Style [
styles of selected text with the Paste Style ]
previously stored styles. v Automatic Final Letter L
e Automatic Final .Letter (88-L): Set Clipboard Options. .
When checked, this feature alters Set Initial Text Display... 3T

the form of certain Greek and R ————
Hebrew letters depending on their

position in the word.

e Set Clipboard Options...: Opens a dialog box which affects the
export of Greek and Hebrew. These options are described below.

e Set Initial Text Display... (38-T): Sets the display details of new
verses which are added from that text. The text display dialog box
is similar to the window of the same name in Accordance, except
that there is no Use as default button. The default options for
each text are the same as those currently
set in Accordance.

Font >
The Text menu lets you change the appearance Size >
of text you select (or enter) using the submenus: Style >
¢ Font: lets you choose from any font Color >
installed in your system. Text Smoothing 2]
e Size: lets you choose from a range of Direction B
sizes. ——————



Windows

Automatic ending
forms

“Smart” accents

e Style: lets you choose the styles of the text, including superscript
and subscript.

e Color: lets you choose from a range of colors.

¢ Text Smoothing (or 8-]) (active only in OS X) turns on the
anti-aliasing which smooths the text (but makes Hebrew text in
particular look ragged).

e Direction: lets you choose the basic direction and justification of
the text in the whole pane. The default is From Left but you can
select From Right, which is used when Hebrew is the primary text.

The Windows menu includes Tile Windows (38-1),

Stack Windows, and the names of the currently Tile Windows 31
open windows. Stack Windows
Text
v Text.1
———
Greek and Hebrew

AccordIt offers sophisticated features to facilitate the use of the Greek and
Hebrew fonts.

When the Automatic Final Letter item (Edit menu or 8-L) is checked,
characters which have a different form at the end of the word are
automatically entered correctly. For example, if you type a sigma in Greek it
takes the ending form. If you follow it with another character (not an accent)
it then changes to the regular form. If you add a sigma in the middle of a
word, the normal form is used. If you now type a space the sigma takes the
ending form. The same features apply to the relevant Hebrew characters,
caph, mem, nun, peh, and tzadi.

AccordIt automatically enters the correct overstrike character as you type.
This applies to accents and breathing marks in Greek, and vowel points and
the dagesh in Hebrew. It enables you to learn just one keystroke for each
overstrike character, and still create correctly accented text.

Most accents and other diacriticals are entered after the character in both
Helena and Yehudit (to the right of the character in Greek, and to the left of
the character in Hebrew). Most are offered with a short, medium, and long
overstrike so that they are correctly positioned over or under each character.
Some marks, such as the Hebrew dagesh, have special positions for specific
characters. In AccordIt you can type any position of an overstrike character,
and it will be converted to the correct overstrike for the character which
precedes it. For example, if you type any dagesh after a character which
takes a dagesh, the correct dagesh will be entered. In Greek, if you enter an
accent and a breathing mark after the same vowel, the correct combination
character is entered. Before an uppercase vowel you will need to enter the
non-overstrike breathing mark (option or shift-option-J) before the vowel, and
any position of the accent, in order to get the combination.
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Text direction

Paste

Copy

The default text direction is from left to right. If you select the Hebrew font
Yehudit from the Font submenu (Text menu), the direction of subsequent
text entry is reversed, and any selected text is reversed to read from right to
left.

AccordIt will automatically use the From Right direction and justification
whenever the first verse added to the text pane is from Hebrew text.

This direction always applies to all text in the pane, so it will affect the
justification of English or Greek text. However, if Hebrew text is added while
the direction is From Left, the verse references will appear on the left of the
verses. This can be corrected by changing the direction to From Right.

See Chapter 22 of the User’s Guide for details on using Hebrew and English
text together.

Clipboard Options

The Clipboard Options in AccordIt affect both the import and export of
Greek and Hebrew text when

you copy to the clipboard 080 Set clipboard options:
or drag and drop. Select Set )

Clipboard Options... (Edit Eeate e e caralll

menu) to open the Clipboard ECunvert LaserGREEK® to Helena
options dialog box. M Convert LaserHEBREW® to Yehudit

Copy from Accordlt

You can copy text from a

word processor in which you "] Convert Greek characters to SuperGREEK®
used the LaserGREEK® or ["] Convert Hebrew characters to Hebraica II™
LaserHEBREW® fonts which "I Remove accents and other diacritical marks
use a slightly different key

mapping than Accordance E Reverse direction of Hebrew characters

fonts. (The Alexandria™ and
Jerusalem™ fonts use the same @
key mapping as LaserGREEK
and LaserHEBREW.)

The two options in the Paste into AccordIt section will convert any

text in these fonts to the equivalent Accordance fonts. This allows you to
incorporate your previous work while continuing to use Helena and Yehudit
fonts. The default setting is that these two boxes are always checked.

In the Copy from AccordIt section, the first two options make AccordIt
convert Greek or Hebrew characters into SuperGREEK® or Hebraica I1® (the
later versions of LaserGREEK® and LaserHEBREW®).

The third option strips all accents and breathing marks from the Greek, and
all cantillations, vowels and dagesh points from the Hebrew text.



The Reverse direction checkbox reverses the direction of each line of the
Hebrew text so that it can be pasted from and into an English language word
processor. The length of each line will be the same as it appears in the text
pane or window. This option applies to text copied into or from AccordIt,
and should be left checked.

The Copy options also apply to text saved as a file. These options are
independent of the ability of the other program to accept font and style
information. If the font information is lost, you can select the text in your
word processor and set the font yourself.

Each of these options apply only when you leave AccordlIt and click on, or
drag a selection to, another program or the desktop. However, if you then
return to AccordlIt and attempt to paste, the checked options will affect the
pasted text. Thus if you strip the diacritical marks, copy text, click on the
desktop or any window other than AccordlIt, and then paste the contents of
the clipboard into AccordlIt, the text is pasted without diacritical marks.

Note: Changes to these settings are NOT retained when you quit
AccordIt.They must be reset each time you open the program.

Note: Unlike Accordance, AccordIt does not support the export of
Hebrew text to a Hebrew language word processor and a right-
to-left font. You can paste or import text only after reversing the
direction, and view it only in Yehudit or LaserHEBREW which work
in a word processor as left-to-right fonts.

Note: Accordance 6.x has additional options for the export of Greek
and Hebrew to other fonts and to Unicode, and for the selective
stripping of the diacritical marks in Hebrew.

For More Information

Visit our website at http://www.accordancebible.com for news of the latest
releases, free downloadable upgrades, tips for users, etc.

If you have questions about using AccordIt software, email or call for
technical support.

Accordance support

OakTree Software, Inc.

Telephone: (407) 339-0266 (9 am to 6 pm Eastern time)
FAX: (407) 339-9188

e-mail: Support@OakSoft.com



